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CAUTION: This instrument contains electronic components that are susceptible to damage by static electricity. Proper handling procedures must be 
observed during the removal, installation or other handling of internal circuit boards or devices. 

Handling Procedure: 

1. Power to unit must be removed. 

2. Personnel must be grounded, via a wrist strap or other safe, suitable means before any printed circuit card or other internal device is installed, 

removed or adjusted. 

3. Printed circuit cards must be transported in a conductive container. Boards must not be removed from protective enclosure until immediately before 

installation. Removed boards must immediately be placed in protective container for transport, storage or return to factory. 
Comments 
This instrument is not unique in its content of ESD (electrostatic discharge) sensitive components. Most modern electronic designs contain components that 
utilize metal oxide technology (NMOS, SMOS, etc.). Experience has proven that even small amounts of static electricity can damage or destroy these 
devices. Damaged components, even though they appear to function properly, exhibit early failure. 

ESD (Electrostatic Discharge) 

Brooks Instrument designs, manufactures and tests its products to meet many national and international standards. These products must be properly 

installed, operated and maintained to ensure they continue to operate within their normal specifications. The following instructions must be adhered to 

and integrated into your safety program when installing, operating and maintaining Brooks Instrument products. 

Å To ensure proper performance, use qualified personnel to install, operate, update, program and maintain the product. 

Å Read all instructions prior to installing, operating and servicing the product. If this instruction manual is not the correct manual, please see back cover 

for local sales office contact information. Save this instruction manual for future reference. 

WARNING: Do not operate this instrument in excess of the specifications listed in the Instruction and Operation Manual. Failure to heed 
this warning can result in serious personal injury and / or damage to the equipment. 

Å If you do not understand any of the instructions, contact your Brooks Instrument representative for clarification. 

Å Follow all warnings, cautions and instructions marked on and supplied with the product. 

WARNING: Prior  to installation ensure this instrument has the required approval ratings to meet local and national codes. Failure to heed this warning can 

result in serious personal injury and / or damage to the equipment. 

Å Install your equipment as specified in the installation instructions of the appropriate instruction manual and per applicable local and national codes. 

Connect all products to the proper electrical and pressure sources. 

Å Operation: (1) Slowly initiate flow into the system. Open process valves slowly to avoid flow surges. (2) Check for leaks around the flow meter inlet 

and outlet connections. If no leaks are present, bring the system up to the operating pressure. 

Å Please make sure that the process line pressure is removed prior to service. When replacement parts are required, ensure that qualified people use 

replacement parts specified by Brooks Instrument. Unauthorized parts and procedures can affect the product's performance and place the safe 

operation of your process at risk. Look-alike substitutions may result in fire, electrical hazards or improper operation. 

Å Ensure that all equipment doors are closed and protective covers are in place to prevent electrical shock and personal injury, except when 

maintenance is being performed by qualified persons. 

WARNING: For  liquid flow devices, if the inlet and outlet valves adjacent to the devices are to be closed for any reason, the devices must be completely 
drained. Failure to do so may result in thermal expansion of the liquid that can rupture the device and may cause personal injury. 

Essential Instructions 
Read before proceeding! 

All pressure equipment with an internal pressure greater than 0.5 bar (g) and a size larger than 25mm or 1" (inch) falls under the Pressure Equipment Directive (PED). 

Å The Specifications Section of this manual contains instructions related to the PED directive. 

Å Products described in this manual are in compliance with EN directive 2014/34/EU. 

Å All Brooks Instrument Flowmeters fall under fluid group 1. 

Å Products larger than 25mm or 1" (inch) are in compliance with PED category I, II or III. 

Å Products of 25mm or 1" (inch) or smaller are Sound Engineering Practice (SEP). 

The Brooks Instrument (electric/electronic) equipment bearing the CE mark has been successfully tested to the regulations of the Electro Magnetic 

Compatibility (EMC directive 2014/30/EU). 

Special attention however is required when selecting the signal cable to be used with CE marked equipment. 

Quality of the signal cable, cable glands and connectors: 

Brooks Instrument supplies high quality cable(s) which meets the specifications for CE certification. 

If you provide your own signal cable you should use a cable which is overall completely screened with a 100% shield. 

ñDò or ñCircularò type connectors used should be shielded with a metal shield. If applicable, metal cable glands must be used providing cable screen clamping. 

The cable screen should be connected to the metal shell or gland and shielded at both ends over 360 Degrees. 

The shield should be terminated to an earth ground. 

Card Edge Connectors are standard non-metallic. The cables used must be screened with 100% shield to comply with CE certification. 

The shield should be terminated to an earth ground. 

For pin configuration : Please refer to the enclosed Instruction Manual. 

European Pressure Equipment Directive (PED) 

European Electromagnetic Compatibility (EMC) 



Installation and Operation Manual 

X-SW-BEST-RevAQuantim 

Part Number: 541B226AAG 

February, 2021 

 

Brooks® Expert Support Tool 

 

iii 
 

 
 
 
Dear Customer, 

 
We recommend that you read this manual in its entirety as there have been some changes since previous 

versions. This will enable efficient and proper use of the Brooks Expert Support Tool software. Should you require 

any additional information concerning Brooks Expert Support Tool, please feel free to contact your local Brooks 

Sales and Service Office; see back cover for contact information, or visit us on the web at 

www.BrooksInstrument.com. We appreciate this opportunity to service your fluid measurement and control 

requirements, and trust that we will be able to provide you with further assistance in future. 

 
Yours sincerely, Brooks Instrument 
 
 

http://www.brooksinstrument.com/
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Chapter 1 Introduction 

 

1.1 Description 

The Brooksô Expert Support Tool is a Windows®-based application that 
provides expanded monitoring & control of the Brooksô digital thermal 
mass flow controller/meter, flow controller/meter, pressure controller and 
remote pressure transducer (RT), and pressure-based flow controller 
modes for servicing tasks that include setup, configuration, calibration, 
tuning, control, monitoring, and troubleshooting. For device 
troubleshooting information, refer also to the deviceôs Installation and 
Operations Manual. 

BEST is a direct replacement for the obsolete BSS/BST software. BEST 
adds support for Quantim and SLA Rev A devices. It does not add 
support for model 4800 devices. 

Use of some features requires a Pro software license which is 
obtainable on a subscription basis. Contact Brooks Instrument to obtain 
a license. See Table 2-2 for a list of which features require a license. 

Note that this user manual covers only the use of BEST with SLA Rev A 
(ñLegacyò) and Quantim B devices. BEST also supports SLA Rev B 
(ñEnhancedò), PC1xx, VDM300, GF40, GF1xx, and GP200 devices. 
Those products are covered by a separate BEST user manual for those 
products. 

 

 
Figure 1-1 BEST Main Screen 

Note that the Brooks Expert Support Tool is meant to be used as 
a startup and troubleshooting tool. It is not intended to be 
permanently connected to the device in your system/application. 
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1.2 How to Use This Manual 

It is recommended that you read the device Installation & Operations 
Manual (IOM) prior to reading this manual. Read this manual in its 
entirety before installing or using the Brooks Expert Support Tool. 

Note that the illustrations of screens from BEST are illustrative ï the 
exact appearance on your computer screen may vary slightly. Also, if 
software versions are shown on the illustrations, your versions may vary 
slightly. 

Note: For device troubleshooting information, refer to the deviceôs 
Installation and Operations Manual. 

 

1.3 Integrated Help 

This user manual (which is searchable) can be accessed directly from 
the software, on the About->User Manual menu item. See Section 5.2. 

1.4 Theory of Operation 

A typical mass flow measurement and control system consists of two 
components: 

Á Mass flow meter. A mass flow meter incorporates a 
sensor that measures the amount of mass flow and 
generates an electrical output signal directly proportional to 
the mass flow rate. 

Á Control valve. 

Mating a control valve with a mass flow meter provides a mass flow 
controller (MFC). 

Implementing a mass flow controller requires using the mass flow output 
signal as one input and a user-supplied setpoint signal as another input 
into a comparator circuit. These two signals are then compared and a 
control signal is generated to operate the opening or closing of the 
valve. The setpoint signal is, in effect, a request that the mass flow 
controller maintain a fixed mass flow rate. 

BEST, which communicates with the device through an RS-232 
connection (or RS232/USB adapter) between the PC and the deviceôs 
service port connector, uses a digital signal based on a proprietary 
protocol. The Service Tool has two operating modes: 

Å Indicator, in which the Service Tool is reporting on the data sent to it 
from the device, which is being controlled by the normal setpoint 
source. 

Å Control, in which the Service Tool user specifies the setpoint, 
overriding the normal setpoint source. 

In either arrangement, the device will attempt to manage the opening 
and closing of the control valve to maintain the amount of mass flow as 
requested by the setpoint source. 

Note that BEST is meant to be used as a startup and troubleshooting 
tool. It is not intended to be permanently connected to the device in your 
application. 
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Chapter 2 Installation 

This chapter describes the system requirements, how to install the BEST 
software onto a personal computer (PC), and how to connect the PC to 
the device. 

2.1 Hardware Requirements 

BEST communicates with Brooks SLA Rev A and Quantim devices via a 
service port connector (or ñdiagnostics portò) that is accessed by 
removing the device cover (see also Section 2.6.1). See also the device 
installation manual.  
 
This port is connected to the computer via a serial port or a standard 
USB port with USB to serial adpater. This requires the following cabling 
as follows: 

 
1.) 3-wire communications cable, Brooks part# S778D023ZZZ 
2.) RS232 to TTL communications interface adapter 
3.) USB to RS232 communications interface adapter (optional, for USB 

port connection) 
 

This equipment may be purchased either along with the Brooks Expert 
Support Tool software or separately from Brooks Instrument. Contact the 
factory or your local representative for details. 

*NOTE: No ñlicense dongleò is required, but a software license is required 
for Pro features of BEST. 

2.2 System Requirements 

This chapter describes system and software requirements to use the 
Brooks Expert Support Tool application on a personal computer (PC). 

The Brooks Expert Support Tool application can be installed on a 
Windows PC with the following requirements: 

Table 2-1 System Requirements 

Component Minimum Requirements 

Operating System Microsoft Windows 10 
Microsoft Windows 8 ï BEST has not been formally 
tested with Windows 8 
Microsoft Windows 7 ï 32-bit/64-bit 

COM Port One dedicated serial port or USB port with USB/serial 
adapter, and RS232 to TTL adapter 

Software License Required for Pro Features (Calibration) 
See Table 2-2 below for specifics 
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Table 2-2 Features Requiring a License for SLA Rev A and Quantim Products 

 Feature Standard (No license) PRO License 

Connection ṉ ṉ 

Terminal Commands X ṉ 

Device Info ṉ ṉ 

Model Code Editing* X ṉ 

Dump File ṉ ṉ 

Wake Up State ṉ ṉ 

Protocol Settings ṉ ṉ 

Get Firmware Revision ṉ ṉ 

Meter Simulate MFC* X ṉ 

Reboot/Power Cycle ṉ ṉ 

Control Source/Valve Control/Set Point ṉ ṉ 

Graph/Basic Status/Meters ṉ ṉ 

Warning Status ṉ ṉ 

Alarm Status ṉ ṉ 

Data Logging ṉ ṉ 

Sensor Zero ṉ ṉ 

Tuning ṉ ṉ 

Calibrate input and output signals ṉ ṉ 

Guided Flow Calibration  
(SLA Rev A Delta/Smart II only) 

X ṉ 

Manual Calibration  
(SLA Rev A Delta only) 

ṉ ṉ 

Graph Settings ṉ ṉ 

Warning Settings ṉ ṉ 

Alarm Settings ṉ ṉ 

Calculators ṉ ṉ 

Top Label Printing ṉ ṉ 
*Model code editing Not supported for Quantim B 
 

2.3 Installing the Brooks Expert Support Tool Application 

This Chapter describes how to install the Brooks Expert Support Tool 
application onto a personal computer (PC). 

Uninstallation of existing versions of BEST prior to installation is not 
required, but recommended. See Section 2.5 for more details about 
uninstallation. 

To install the Brooks Expert Support Tool application, download the BEST 
installer file from the Products/Software Chapter of the Brooks Instrument 
website (www.brooksinstrument.com). Once the installation file is 
downloaded, decompress if necessary. 



Installation and Operation Manual 

X-SW-BEST-RevAQuantim 

Part Number: 541B226AAG 

February, 2021 

 

Brooks® Expert Support Tool 

 

2-3 
 

Before installing, open and read the Readme file for last-minute updates 
and helpful notes that may not be included in this user manual. 

Before starting the BEST installer, it is recommended to disconnect or 
power down any mass flow devices connected to the computerôs serial 
ports or USB ports. 

Run the setup.exe file - it is recommended to run this file as an 
administrator. Right click on the file and a pop-up menu appears. (See 
Figure 2-1). Click ñRun as administrator.ò 

 

 
Figure 2-1 Running Setup.exe as an Admin 

Next, follow the installation instructions provided by the software. It is 
recommended to install BEST and its components in the default folders 
provided by the installer. 

The installer will install BEST and its required software components, 
including versions of FloCom, FloComPlus and the FlocCom databases. 

For users who require a specific version of the FloCom database 
component, during the installation, the user will be presented with a 
software component selection menu (See Figure 2-2). Uncheck the item 
FloCom Databases to preserve the currently installed version/not install 
the version from the installer.  

*NOTE: It is recomended to run this version of BEST with certain versions 
of FloCom, FloComPlus, and  FloCom database ï these should be 
installed for maximum functionality. If you do not install the database 
version from the installer you must ensure that the desired version of 
FloCom database is installed separately from the BEST installer. 
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Table 2-3 FloCom Recommended Versions Installed with BEST 5.10.0.0 

Program Required Version 

FloCom 4.16 

FloComPlus 1.41.03 

FloCom Database 20200813 

 

 
Figure 2-2 Installer Software Component Menu  
(Your versions may vary) 

Virtual COM Port Driver: To use BEST with the VDM300 device it is 
necessary to install the virtual COM port (serial port/USB) driver. This 
driver is normally installed via the BEST installer. Make sure that the 
Virtual COM Port Driver check box is checked (see Figure 2-2).  

See also the ReadMe file for more information about the Virtual COM port 
driver. 

USB to Serial Port Driver: To use BEST with the USB to RS485 
adapter, this driver is needed. 

During installation, if it is installing a software component that already 
exists, the installer may present you with the options of Modify, Repair, or 
Remove, or similar: typically, choose repair. If it presents you with the 
options Complete or Custom, choose Complete. 

The installer will optionally create an item in the Brooks Instrument 
program group and a shortcut icon on the Windows desktop. 

Upon completion of installation, a software license must also be installed 
for access to Pro features of BEST. Contact Brooks Instrument to obtain 
a license. License installation instructions are covered in Section 5.1.2. 
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2.4 License Installation 

To obtain a license, the user must contact Brooks Instrument to obtain a 
yearly license subscription. The user will receive a license key (a 
number), then enter it in the License Key text block. 

*NOTE: After receiving your license key, store it in a secure location 
(backed up and secure from unauthorized use) for later retrieval. 

Normally, the license installation process requires an Internet connection. 
A license can be installed without an Internet connection ï contact Brooks 
Instrument for details.  

To install a license, click on the menu Help->License->Install License. 
The window in Figure 2-3 will appear.  

 

Figure 2-3 License Installation Window 

Copy and paste your license key text into the License Key text box. Then 
click Install. The software will attempt to use an Internet connection to 
contact Brooks Instrument to verify the license. Then the license will be 
installed on the local computer. You will receive a message when it is 
finished. To view the installed license, click the menu item Help->License-
>Info. See also Section 5.1.1. 
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Figure 2-4 License Information Window 

 
 
 
 
 
 
 
 
 

2.5 Uninstalling the Brooks Expert Support Tool Application 

To uninstall BEST, go to the Windows Control Panel -> Programs and 
Features. Look for any items entitled ñBrooks Expert Support Toolò. Right 
click the item and select Uninstall. Follow the onscreen instructions. 

Repeat for any items with the title ñBrooks Expert Support Toolò. 

*NOTE: The uninstallation does not uninstall any of the auxiliary 
components such as FloCom or FloCom databases, installed with BEST. 
These do not necessarily need to be uninstalled, but to uninstall, repeat 
the above paragraph for the items ñFloComò, ñFcPlusò, etc. 

 

2.6 Connecting the PC to the Device 

This Chapter describes the procedure for connecting the PC running 
BEST to the deviceôs service port, for both the SLA Rev A and Quantim 
devices. 
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2.6.1 Connection Hardware Requirements 

The following tools and cables are required to connect the PC serial port 
to the deviceôs service port: 

¶ 3-wire communications cable (between the interface connector 
and the deviceôs service port connector) 

o Brooks part# S778D023ZZZ 

¶ RS-232 to TTL communications interface adapter. 

¶ USB to RS-232 to TTL communications interface adapter (optional for 
use with USB port) 

¶ Phillips head screwdriver 

 
Figure 2-5 3-Wire Communications Cable and Adapter 
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2.6.2 Connection Procedure 

 
 

To connect the PC to the deviceôs service port: 

1. Turn off power to the device. 

2. Remove the standard cable from the deviceôs 15-pin D-connector. 

3. Remove screws from the top cover. 

4. Remove the cover. 

 
Figure 2-6 SLA Rev A Device with Cover Removed 

5. Connect the 3-wire communications cable to the deviceôs service port, 
the black connector located behind the D-connector. Align the 
communications cableôs 5-pin connector with the black wire towards 
the center of the device (towards the LEDs), as shown in the following 
illustration. 
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Figure 2-7 3-wire communications cable attached; black wire toward LEDs 

6. Connect the RS232 to TTL communications adapter to the D-
Connector of the 3-wire communications cable. Make sure to connect 
the end labeled TTL to the cable. 

7. If you are using your PCôs serial port, connect the RS232 to TTL 
adapter directly to a serial port on your computer. Make sure to 
connect the end labeled RS232 to the serial port. 

 
Figure 2-8 Cable/Adapter Connection to PC 

8. If you are using your PCôs USB port, connect the USB to RS232 
communications adapterôs D-connector to the RS232 to TTL adapterôs 
end labeled RS232. Then connect the other end of the USB to RS232 
adapter to the computerôs USB port. 

9. Reconnect the standard cable to the deviceôs D-connector. This 
connection is used to apply power and the analog setpoint to the 
device while using the Service Tool. 

10. Turn on power to the device. 
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2.6.3 Disconnecting the PC from the Device 
 

When you are done using the Service Suite, you should disconnect the 
PC from the device and reinstall the deviceôs cover. 
To disconnect the PC from the deviceôs service port: 

1. Detach from the device using BEST. 
2. Exit from BEST software, optionally. 
3. Turn off power to the device. 
4. Disconnect the standard cable and the 3-wire 

communications cable from the device. 
5. Disconnect the interface adapter from your PC. 
6. Place the cover onto the device, and reattach it using the 

screws. 
7. Reconnect the standard cable to the deviceôs 15-pin D-connector. 

You can now reapply power to the device and begin using it in a process 
application. 
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Chapter 3 Basic Operations 

This Chapter gives a general introduction to the basic operation of BEST, 
including starting BEST, the main screen, establishing communications 
with a device, viewing the main graph window, detaching from a device, 
and the menus. 

3.1 Main Screen 

To start BEST, select BEST from your Start menu, or double-click its 
application shortcut. The main window displays, with no devices 
connected. 

 
Figure 3-1 Main Screen with Device Connection Window 

The Title Bar shows the name and current version of the software. The 
title bar can also be used to select, move, and maximize the window, 
according to Windows conventions. 

The Menu Bar is where most functionality of BEST is accessed. BEST 
windows are opened from the menu bar. Menu items are typically 
accessed from left to right and top to bottom. 

The BEST desktop is where all opened BEST windows exist. This is 
similar to the Windows desktop, except that this desktop contains only 
BEST windows. See also Chapter 6. 

The Status Bar shows useful instructions and messages about the 
current status of the software and its processes. 

If the user is using dual monitors, the user may gain additional space for 
windows by dragging the edge of main screen across to the additional 
monitor. 
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When the software first starts, it shows the device connection window in 
the center of the Window Background. To use most features of BEST, 
you must first ñattachò (or establish communication with) a device using 
the connection window. See Section 10.1 for more details about the 
Connection Window. 
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3.2 Attaching to a Device 

The first thing to do is to establish communications with (or ñattachò to) a 
device. 

When BEST software starts, no devices are attached. Devices are 
attached via the device connection window. For convenience, the 
software opens the device connection window for you upon startup. 

First, in the Device Connection/Port drop-down list (See Figure 3-2), 
select the COM Port you are using to connect to your device.  

Next, select the desired Baud rate from the Device Connection/Baud rate 
drop-down list. Most users will choose optimize, which will automatically 
select the fastest baud rate that successfully communicates with the 
device. if you have trouble attaching to a device, you can try a lower baud 
rate to troubleshoot. Your selected port and baud rate selections will be 
retained by BEST for your convenience. 

Click the Next > 1 Device button to find the connected MAC address. 
After a few moments, if a device is located, its MAC ID (or ñaddressò) is 
listed in the Mac ID drop-down list. Note that for SLA Rev A and Quantim 
devices, the MACID will always be 0. 

Once a deviceôs MAC address is located, click on the Attach button. After 
a few moments, if it is attached, a row appears in the connected devices 
box, as shown in Figure 3-2. 

 
Figure 3-2 Device Connection Window, Device Attached 

If a device has DeviceNet, Ethercat, or FieldBus, a window will pop up 
asking if you want to place the device in the executing state. 
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Figure 3-3 Executing Mode Window 

If you need to control the deviceôs setpoint with BEST, click Yes. 

Once the device is attached, close the Device Connection window. 

Likewise, when detaching from a device, it may ask you if you want to 
place the device in the idle state. 

 

Figure 3-4 Idle Mode Window 

See also Section 10.1 for more details about device connections. 

3.3 Main Graph 

Once a device is attached, you can run the main graph to watch the 
behavior of the device. Click on the green button in the upper left corner 
of the Devices Connected block. The main graph window will open, then 
Click Start. 

 

Figure 3-5 Graph Window 

See Section 8.4 for more details about the graph window. 
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3.4 Closing the Session with the Device and Exiting BEST 

To close the communication session with a device and exit the software, 
open the File menu and choose Exit, or click the windowôs close button 
(the X in the upper right corner). Exiting the software automatically closes 
all communications with the device. 

Alternatively, the user may close the communications with (or ñdetachò 
from) the device, by opening the Device Comm->Connection menu. Then 
click Detach. The user may attach to another device, if desired. 

3.5 Brooks Expert Support Tool Conventions 

The Brooks Expert Support Tool was designed to remain consistent with 
regard to how the user interacts with the application across all functions 
and features. It is also generally consistent with Windows user interface 
conventions. 

The following text field conventions apply throughout the software: 

Text fields with a gray background display a read-only value (such as the 
Current Position (%) in Figure 3-6. 

Text fields with a white background are editable (such as Set Valve 
Position (%) in Figure 3-6). 

Usually, editable text fields update the software or device either when the 
user clicks the Enter button, when the focus moves to another field by 
using the Tab key or mouse, or when a separate apply button is clicked 
(see each Chapter in the manual for specific instructions). 

If a text box contains ñNaNò or ñn. def.ò it means ñNot a Numberò, not 
defined, or invalid calculation result. 

Many windows also require numeric input from the user. This type of 
window is also called a ñformò. For numeric input, forms often feature 
numeric up/down controls. See Figure 3-6 for an example of a numeric 
up/down control (circled). 

 
Figure 3-6 Example Numeric Up/Down Control 

Up/down controls help prevent invalid numeric data entry. Click the up 
arrow to increment the numeric value, or the down arrow to decrement. 
Up/down controls also have maximum and minimum values. You may 
also type in a number directly, but it wonôt allow non-numeric entry. Also, 
in some cases, it wonôt accept a thousands separator character (for 
example, ñ,ò in English culture). In most forms, you may also click enter to 
accept the entered value, or move the focus off the control to another 
control on the form. 
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Data Entry and International Locales: While BEST doesnôt translate all 
words from the English language, BEST supports various number and 
date formats for data entry and display, according to the userôs computer 
settings for that region (see Control Panel->Region and Language on 
your computer). BEST uses the userôs Windows settings for region and 
locale for most numeric data, except where noted in this manual. For 
example, when entering a decimal number in English a user might type 
1.234 into a text box, but for German culture, one would enter 1,234 
because in that culture the comma is the decimal separator. 

*NOTE: In some BEST windows you must always enter English formatted 
numbers (because that is what the device expects). For example, in the 
terminal window, you must use English decimal number formats because 
the commands that a device accepts require English. In those types of 
windows, a statement will be present on the form as a reminder. 

For most windows in BEST, for data entry, you must use the format of 
your region, except where noted in this manual. Likewise, most windows 
will display numbers in the format of your region, except where noted in 
this manual. 

The sample illustrations in this manual are shown using the English 
region formatting. 

3.6 Menu Bar 

The Menu Bar (see Figure 3-1) is where most functionality of BEST is 
accessed. BEST windows are opened from the menu bar, and then those 
windows will exist on the BEST Desktop. Menu items are typically 
accessed from left to right and top to bottom. 

Note that this manual shows all menu items. Certain menus may not 
appear if the features of those menus are not supported by the currently 
selected device.  

Subsequent chapters of this manual describe each of the menus in detail. 
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Chapter 4 File Menu 

The File Menu Item contains a place to exit the program. See Figure 4-1 
below. (You may also exit the program via the ñXò in the upper right of the 
title bar, according to Windows convention). 

 
Figure 4-1 File->Exit Menu 
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Chapter 5 Help Menu Item 

The Help Menu Item is where information about the BEST software can 
be accessed, including the current version of BEST, licensing options, and 
user help. A device connection is not required to access these menu 
items. 

 
Figure 5-1 Help Menu 

5.1 About Window 

The About-> About Menu Item is where information about the current 
version of BEST and it software components can be viewed. Information 
provided includes the current version of BEST and it software 
components. (The current version of BEST is also always visible in the 
main screenôs title bar.) 

 
Figure 5-2 About Window  
(Your versions may vary) 
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5.1.1 License Info Window 

The License Info Menu Item is where information about installed licenses 
for the current version of BEST can be viewed (but not updated). The user 
may also set options about when to be reminded of license expiration. 

 
Figure 5-3 License Information Window (Your versions may vary) 

5.1.2 Install License Window 

The Install License Menu Item is where licenses may be installed (and 

uninstalled). The user must contact Brooks Instrument to obtain an 

annual license subscription, if desired. The user will receive a license key 

(a number), then enter it in the License Key text block. 

*NOTE: After receiving your license key, store it in a safe location 

(backed up and secure from unauthorized use) for later retrieval. 

Normally, the license installation process requires an Internet connection. 

A license can be installed without an Internet connection ï contact Brooks 

Instrument for details. 

 
Figure 5-4 License Install Window 
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5.1.3 EULA Window 

The EULA is where the user may view the End User License Agreement 
(EULA). 

 

5.2 User Manual Menu 

The BEST user manual (which is searchable) can be accessible directly 
from the software under the About->Help menu. A PDF file reader (such 
as Adobe Reader or Microsoft Edge) must be installed on the computer to 
read this file. 

 

5.3 ReadMe Menu 
 

The user may view last-minute updates as well as technical and useful 
troubleshooting information from this menu. 
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Chapter 6 Window Menu 

The Window Menu Item is where BEST windows can be accessed and 
controlled. 

A note about BEST Windows and the BEST desktop: BEST windows 
exist on the BEST desktop (see Figure 3-1). This is similar to the 
Windows desktop, except that the BEST desktop contains only BEST 
windows. 

BEST windows are sized and closed in a similar way as in the Windows. 
Most BEST windows can be sized, minimized, maximized, restored. 
Some BEST windows have minimum and/or maximum sizes. Multiple 
windows may be opened with some exceptions. Some windows, such as 
calibration windows, when they are open, do not allow access to other 
windows until they are first closed. (These are called ñmodalò windows). A 
modal window cannot be minimized or maximized, but may be resized by 
dragging the sizing handle in the lower right corner of the window (if the 
windows is not maximized). 

Note also that the title bar of each BEST window shows the serial number 
of the device associated with that window. 

If any windows are open in the BEST desktop, they will be listed in the 
Window menu under the Arrange (See Figure 6-1). Clicking one of those 
menu items will activate that window. 

 

Figure 6-1 Window Menu 

The Close All Window menu item closes all windows (for all devices). 

The Cascade Window menu item, arranges all open windows in a 
ñcascadeò arrangement from the upper left corner of the windows. See  
Figure 6-2 below. 
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Figure 6-2 Cascaded Window Layout 

Tile will arrange all open windows in a ñtileò arrangement. See Figure 6-3 
below. 

 
Figure 6-3 Tiled Window Layout 

Minimize All minimizes all windows to an icon representation. See 
Figure 6-4 below. 

*NOTE: If a modal window is minimized, it will disappear into an icon at 
the bottom of the screen. To restore it, click on the icon. 
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Figure 6-4 Minimized Windows 
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Chapter 7 Settings 

The Settings Menu Item is where BEST software options can be 
changed to the userôs preferences. These are software options, not 
device options. Most of the features in this menu do not require a device 
connection. Menu items shown depends on device type. 

 
Figure 7-1 Settings Menu 

7.1 Graph Options 

The Graph Options is where the user can select options and preferences 
for the operation of the main graph window. Here the user can select the 
data units, scaling, and graph legend options. See Figure 7-2 for the 
Graph Options window. 

 
Figure 7-2 Graph Options Window 

For each graph parameter (flow, pressure, temperature, etc.), the user 
can choose which parameters to show on the graph, legend, and meters 
panel (See Section 8.4 for more information on the meters panel of the 
main graph window). 






















































































































































































































